
Important: Form must be filled out in Adobe Reader 8 or above for form functionality

        204 Submitted or on file.  Note: If NOT on file, complete Payee Setup 204 form
Document #:  I Enter all payments made to or on behalf of the traveler from 

Section 3 of corresponding TAR, CTE Card USBank Statement, or 
USBank Transaction History

See the Form Guide for help with filling out and submission
Vendor #:@ Date Due:

Traveler's or 
Cardholder's Name: 
(Last, First, M.)

Trip Number
Expenses TAR CTE

Team Affiliation (Optional): Airfare

Traveler's Email: Phone: Form Prepared By: Reg Fee
Campus Mail Stop: Dept / Division:    Lodging
(or)Traveler's Address: E-mail: Other

Phone: Total 
Additional Notes (Optional): Enter cash advances from UCSC

Cash Advance
All Actual Expenses: Enter the total expenses below from all payment methods for each business purpose. To itemize expenses see attached TERF Worksheet.

Business Expense Type

Total Expense Description of Expense:
Date

Business Purpose

Destination

Personal Car Mileage   (1/1/2020)
Personal Car Mileage 
Reimbursement          (57.5￠/mile)
Airfare *

Rental Car * (excludes insurance)

Other Transportation

Parking/Tolls

Conference Registration *

Lodging (room + tax  only) * 

Meals & Incidentals ($62 max/day or 
(O) CONUS/diem)
Misc. & Supplies (Explain)

Entertainment (explain with ERA)

TOTALS: Total of all actual expenses

* Must submit original itemized receipts regardless of amount
<Less payments made on behalf of traveler>

All actual Travel/Entertainment expenses paid for 
with the CT&E card are not reimbursed, so reduce 
from the actual expense total

Traveler's certification: I certify the above are actual expenses incurred by me while on official 
University business per the dates shown, and that the original receipts are attached for each
expense of $75.00 or more, per UC policy (G-28).  I certify that I have complied with CA's auto 
liability insurance law while operating my personal auto on University business.

<Less Cash Advance> Cash Advance is reduced from total expenses

Reimbursement or <Payment Due>
Amount due back to Cardholder, auto populates 
line one of reimbursement, may be split funded 
by clicking the custom amount box.

Affiliation

U.S. Citizen Yes No

CTE Travel & Entertainment Reconciliation

Travel

Supplies Other

Entertainment Travel

Supplies Other

Entertainment Travel

Supplies Other

Entertainment Travel

Supplies Other

Entertainment

Section 1:

Section 2:

https://its.ucsc.edu/software/acrobat-etla.html
https://financial.ucsc.edu/Financial_Affairs_Forms/Payee_Setup_204.pdf
https://policy.ucop.edu/doc/3420365/BFB-G-28
https://aoprals.state.gov/web920/per_diem.asp


Reimbursement to Traveler

Fund Organization Account Activity Amount Description of Expense Doc. Ref. Number

Transfer of Expense 

Fund Organization Account Activity Amount Description of Expense Doc. Ref. Number

Payment Due From Traveler: TOE Total: Credit to Default 
Cardholder FOAPAL:

Traveler's certification: I certify the above are actual expenses incurred by me while on official 
University business per the dates shown, and that the original receipts are attached for each 
expense of $75.00 or more, per UC policy (G-28).  I certify that I have complied with CA's auto 
liability insurance law while operating my personal auto on University business.Traveler Signature Required Date:

Tier 1: Signature Required: Date: Senior Officer Auth Signature: (If required) Date:

Funding Authorization (PI, Fund Manager, Advisor) ETP- exception to policy

Tier 2: Signature Required: Date: Other Departmental Approvals: (If required) Date: 

Funding Authorizer Verification (Advisor, Research Accountant) Ex. Other Departmental Expense Authorizor v2.8 - 1/3/2020

Check box if split funding reimbursement or to clear the field

Email completed TERF and required supporting documentation/reciepts to ctecard@ucsc.edu

Section 3:

Section 4:
Check box if your department will process TOE(s)

mailto:ctecard@ucsc.edu
https://policy.ucop.edu/doc/3420365/BFB-G-28




Entertainment Reporting Addendum Form How To: 


The updates made to the Entertainment Reporting Addendum (ERF) have kept the general outline and 
use consistent.  Here are the changes made and how to use them. 


Section 1: 


 


Event Type: Select the event type from the drop down menu.  Note that certain event types will require 
a Host Signature to accompany the event. 


Food/Beverage Purchased: Select the food/beverage type for that specific event.  Four rows have been 
added to accommodate multiple meals at the same event (EX: Lunch and Dinner). 


Per-Person Cost: This field will auto calculates between Food/Bev Cost and Number of Participants.  It 
will then reference the meal type and if the amount is above policy limit the text color will turn red. 


Method of Payment: Check the box next to any payment method that was used for the expenses 
incurred. 


Section 3: 


 







TOE Section: 4 lines have been added to the TOE section to account for multiple funding sources.  A 5th 
line will appear when the Out-of-Pocket expenses box is checked above, overwriting the last line as this 
designates the ERA as a straight reimbursement. 


Transfer of Expense Total: auto populates with the total of all food, beverages, and supplies from 
Section 1 when CTE Card or Pro-Card boxes are selected.  The text color will remain red until the total 
amount in the TOE section is equal to these expenses. 


Signature Section: Electronic Signatures are now accepted on this updated form.  Simply follow the 
prompts when the box is selected to add or create a signature for the document.  Once the appropriate 
signatures have been added, the form and supporting documents can be submitted via email. 


 








CTE Travel & Entertainment Reconciliation Form How To: 


The new CTE Travel & Entertainment Reconciliation form (TERF) should be filed within 45 days of the 
conclusion of your travel, but it is recommended that you do so within 10 days of returning from your trip. 


Your department/division may require more documentation in addition to FAST’s requirements. Please speak 
with your divisional/department leader to find out what is required before you submit your form. If you have 
more than 4 separate trips or entertainment events, you will need to fill out additional TERFs and attach them 
to the back of your original TERF. 


Tip: It is recommended that you fill this form out electronically so that you can benefit from the automatic 
calculations, electronic signatures, and electronic submission that the form allows for. 


Attachments: The following documents are attached to your TERF and can be accessed by selecting the 
embedded links in the PDF or selecting them from the Attachments column: TERF How To, ERA, ERA How 
To, TERF Worksheet.  The TERF Worksheet is used to provide itemized documentation of expenses and 
attached for submission with the TERF. 


Top of Form: 
 


 
Adobe Reader: This form has been designed and optimized for use with Adobe Acrobat/Reader. This means 
for full functionality it should be opened and filled out with Adobe Acrobat or Adobe Reader. Note: the link will 
direct the user to UCSC’s ITS website for download and terms of service. 
 
204 Submitted or On File: Check this box if traveler has recently completed the Payee Setup 204 form or 
already has an account in the BANNER Financial System. If you know that the traveler will be seeking 
reimbursement but does not have an account in Banner, ask them to complete a Payee Setup 204 form and 
submit it to FAR. 


Personal Information: 


 


Traveler’s Name: Enter sole traveler or group leader’s name as it was entered on the Payee Setup 204 form. 
For group leaders attach a list of co-traveler names or enter those names into the “Additional Notes” section. 


Team Affiliation: Enter the team affiliation tied to the traveler or group. If there is no team affiliation leave 
blank. 


Traveler’s Email: Provide preferred active email address. 


Phone: Enter the best number to contract traveler (7 or 10 digit). 



https://its.ucsc.edu/software/acrobat-etla.html





Campus Mail Stop or Payment Address: Provide address or campus mail stop where physical check 
payments should arrive. If traveler has a direct deposit BANNER account provide desired address where a 
physical check should be sent if one were to be created. 


Office Use: 


 


Document #, Vendor #, Date Due: This section is for FAST use and should be left blank. 


Affiliation: 


 


Affiliation: Select appropriate option between Visitor, UC Student, or UC Employee. 


Select Campus: Select the campus the traveler is currently employed at or attending. 


U.S. Citizen: Select citizenship status. 


Foreign Visa Type: Select the choice that applies to the traveler. 


Form Prepared By: 


 


Form Prepared By: Enter name of person preparing form if not the traveler. If the traveler is preparing form, 
leave section blank. 


Dept/Division: Department or division of form preparer. 


E-Mail: Provide preferred active email address of preparer. 


Phone: Enter preferred number to contact form preparer (7 or 10 digit). 


Payments Made to or on Behalf of Traveler: 







Trip Number: If a Travel Advance Request form was submitted pre-travel then enter the assigned trip number. 
Otherwise enter N/A or leave blank. 


TAR Payments: If no expenses were paid on behalf of the traveler, or reimbursed early before the trip leave 
this area blank. If a TAR form exists for the trip, enter all expenses from the TAR Form’s Section 3 “payments 
made to or on behalf of traveler.” 


CTE Payments: If no expenses were paid via U.S. Bank’s Corporate Travel & Entertainment Card, leave this 
area blank. If expenses were incurred, enter all appropriate categorized expenses directly shown on the CTE 
Card statement, or CTE Card transaction history. 


Cash Advance: If a cash advance was issued with a TAR enter the dollar amount in this field. 


All Actual Expenses: 


TERF Worksheet: The link will open the attachments section of this PDF.  Select the TERF Worksheet excel 
from that list to open and fill in all itemized expenses for each business purpose. 


Business Purpose: Select the option that best fits the purpose of the trip, or select the “Manual Entry Here” 
option to write in your own business purpose. 


Date: Enter the depart and return dates for the travel including transit to and from the destination. 







Business Purpose (Detail): Add additional details to substantiate the business purpose of the trip, such as 
conference name, and ensure supporting documentation is attached, such as the conference agenda. 


Destination: Provide city and state (domestic), or city and country (foreign). 


Personal Car Mileage & Reimbursement: If a personal car was used enter the actual miles driven for entire 
trip from your workplace. The form will calculate the reimbursement amount due back at the current designated 
rate.  For further information on Personal Car Mileage & Reimbursement see the Travel Guide 


Airfare: Enter the cost of all airline tickets, whether purchased through a TAR, CTE Card, or Out-of- Pocket. 


Rental Car: Enter rental car cost here.  Fuel costs for a rental vehicle should be added to the Other 
Transportation field. 


Other Transportation: Costs for taxis, shuttle services, ride share, rental vehicle fuel costs, etc. should be 
entered in this row. 


Parking/Tolls: Enter any meter, parking garage, or bridge toll costs in this row. 


Conference Registration: Enter any conference/event registration costs here whether being reimbursed for 
Out-of-Pocket, charged to CTE Card, or previously paid directly by the University or through a TAR. 


Lodging: Hotel Expenses are entered in this row. Only room charges and applicable taxes should be entered 
in this row. A non-cash hospitality gift expense up to $75 can be entered here if traveler stayed with relatives or 
friends instead of incurring hotel costs. 


Meals & Incidentals: Enter actual expenses for meals in this row (up to daily (O)CONUS per diem rates). 


Misc. & Supplies: Include other expenses not mentioned above in this row (baggage fees, housekeeping tips, 
etc.). 


Entertainment: List any entertainment related expenses, and complete the attached Entertainment Reporting 
Addendum with proper authorization signatures and notation. Leave blank if no entertainment expenses were 
incurred. 


Totals: If using Adobe Acrobat, all totals will self-calculate, giving the total amounts for each trip and for each 
expense type. If manually filling the form, ensure to total each row and column. 


Comments: Enter pertinent information, description of expenses, or important statements about the travel for 
each expense type here. 


Traveler Certification and Totals: 


Required Documentation: Supporting documentation must be submitted for Airfare, Conference Registration 
Fee, Rental Car, and Lodging regardless of amount. 


Traveler Certification: This notifies the traveler of UCOP policy that any expense of $75 or more that must be 
supported by an appropriate documentation, and that if a personal auto was used it complies with CA’s auto 
liability insurance. 



https://financial.ucsc.edu/Pages/travel_guide.aspx#Travel_RentalCar

https://aoprals.state.gov/web920/per_diem.asp





Payments Made on Behalf of Traveler: TAR and CTE Card purchases from the above section are added in 
here. 


Reimbursement or <Payment Due>: is calculated by the following equation: 


All Actual Expenses – Travel Advance Request – Corporate Travel & Entertainment Card – Cash Advance = 0, 
Payment Due, or Reimbursement to Traveler. 


This displays the net total of all expenses. A negative value means that a payment is due to the UC Regents 
on behalf of the traveler, and can be deposited with a Travel Cash Advance Repayment form at the Cashier’s 
office; attach your deposit slip/receipt to the Post Travel form before submitting. If the value is positive the 
traveler will receive a reimbursement. 


Reimbursement to Traveler: 


Transfer of Expenses: Provide the 5-digit fund number, 6-digit organization code, and 6-digit account code 
representing the unique funding source for each item, as needed. Additionally, provide the 6-character activity 
code, if applicable. Enter the amount and notes you would like to assign to each FOAPAL.  A Document 
Reference Number can be added for internal use, if desired.  If no Transfer of Expense is required leave blank. 


Transfer of Expense Totals: 


Manual Reimbursement Journal Entry (Check Box): If a reimbursement is due back to the traveler, the total 
due from Out-of-Pocket expenses will auto populate into the Amount column in line 1 of the Reimbursement 
section. If this amount needs to be changed, you can select the check box to reset the field and enter in a 
custom amount (such as splitting between FOAPALS). 


Reimbursement to Traveler:  Provide the 5 digit fund number, 6-digit organization code, and 6-digit account 
code representing the unique funding source for the reimbursement.  If no reimbursement is due to the traveler 
leave section blank.


Transfer of Expense: 



https://financial.ucsc.edu/Financial_Affairs_Forms/Travel_Cash_Advance_Repayment.pdf





Signatures: 


Authorization: For additional information on appropriate authorization visit the Authorization and Approvals 
section of the Travel guide. The Travel & Entertainment Reconciliation Form allows for Electronic Signatures to 
submit, with the Traveler, Tier 1, and Tier 2 all being required. Senior Officer, or other Department 
Authorization may be necessary due to budgetary restrictions or policy guidelines.  Please note additional 
signatures required on the Entertainment Reporting Addendum (ERA), as needed.  These authorizers may be 
different than those required for travel authorization. 


Submission: Once all authorized signatures have been added, the form and required supporting 
documentation (lodging, airfare, rental car, conference registration, any expense $75 or more, etc.) can be e-
mailed to ctecard@ucsc.edu. 


U.S. Bank Statement/Transaction History Download and Review: 


Logging On: 


Go to U.S. Bank Account Login Page to gain access to your account.  Log in using the appropriate details, if 


Payment Due From Traveler: Carries over from page 1 of form. If a payment is due from the traveler this field 
will auto populate in red. 


Transfer of Expense Total: The sum of all 16 FOAPAL lines from the TOE is calculated here. 


Credit to Default Cardholder FOAPAL: Enter the default FOAPAL assigned to the Traveler’s CTE Card. If no 
CTE Card was used put N/A. 



https://financial.ucsc.edu/Pages/travel_guide.aspx#Travel_Approvals_WaysToPay

https://financial.ucsc.edu/Pages/travel_guide.aspx#Travel_Approvals_WaysToPay

https://financial.ucsc.edu/Pages/travel_guide.aspx#Travel_Approvals_WaysToPay

mailto:ctecard@ucsc.edu

https://www.access.usbank.com/cpsApp1/AxolPreAuthServlet?requestCmdId=login#viewAnchor





you have not established your account use the Register Online option and follow the prompts. 


Main Page: 


Once logged in, you will be taken to your main account page.  From here you can view current statements, 
update personal information, print previous statements, etc. 


Transaction History Report: 


To fill out your Travel & Entertainment Reconciliation Form (TERF), you will need to download your current 
transaction history report if the statement hasn’t closed, or a current statement if the transactions have posted 
to the account.  Select Transaction Management then View Previous Cycle to view either of these. 


Select Billing Cycle: 







 
 
Select the billing cycle that the expenses occurred upon for the TERF. 
 
Downloading Statement: 


 
 
Once the appropriate billing has been selected, all charges made during that period will be visible.  Selecting 
Print Account Activity will open an option to download the statement (some variation in step due to different 
internet browser preferences). 







 
Account Statements: 


 
 
Selecting Account Information from the left column of your main page will also open a page to view all previous 
card statements. 
 
Cardholder Account Statement: 


 
 
Selecting the Cardholder Account Statement will open all previous statements, which are then directly 
downloaded when one is selected. 
 
Reconciling Statement: 







 
 
Once downloaded, review the statement for accuracy.  If all charges can be verified, then proceed to enter the 
appropriate expenses into both the CTE Card Expenses column and the All Expenses Section of the TERF.  
  
Tip: The CTE Card Expenses column will match exactly the charges pulled from this statement or transaction 
history.  The All Expenses Section may differ if a TAR, Cash Advance, or Out-of-Pocket expense was also 
incurred. 


 







Preparing Receipts 
 
Approach A 


• Highlight and annotate receipts on the spot. 
• Take a picture or use an app (currently under development) to take a picture. 
• Create a folder to store pictures. 
• Once able, download and join photos in a PDF (by trip, category, date). 
• Upload to your folder, save as “Receipts Traveler’s Name Date” (month of the statement/ 


ending month; EX: Receipts John Doe 01.2019). 
 
Approach B 


• Keep paper receipts. 
• Tape to paper as done previously, with appropriate labels. 
• Highlight and annotate the paper or the receipts. 
• Scan piece of paper with the receipt attached. 


 
Preparing Expenses 


• Go to US Bank (https://www.access.usbank.com). 
• Organization Short Name “uofca”. 
• Enter name and password. 
• Select “Reporting” on the upper left side. 
• Select “Transaction Summary”. 
• Enter Statement first and last date (for example XX/23/18 to XX/22/18). 
• Scroll down to “Report Output”. 
• Select “Excel”.  
• Press button for “Run Report” and a small window will open with an Excel Spreadsheet.  
• Open Excel Spreadsheet. 


 
Preparing Google Share Template 


• Go to “Template US Bank Download” File > “Make a Copy”. 
• Rename copy “Spreadsheet Traveler’s Name Statement month.year (EX: Spreadsheet 


John Doe 01.2019).  
 
Moving Expenses from US Bank to Template 


• Open US Bank Excel Sheet. 
• Highlight data in columns “H” (Merchant Name) through “K” (Transaction Date) (note: 


careful to just highlight the data and not the header row). 
• Edit > Copy. 
• Go to “Template US Bank Download” and place cursor in upper left corner cell under 


header of Column A (“Merchant Name”), Edit > Paste Special > Paste Values Only. 
 
Categorizing Expenses in Template  


• Go through expenses line by line. 
• Select Trip A, B, C, D.  
• Select FAST Category. 
• Select Payment method. 
• Indicate that you have the receipt.  
• Explain any details Tier 1 or Tier 2 need to know about this expense. 


 



https://www.access.usbank.com/





Adding Cash and/or Personal Card Payments  
• For expenses not on CTE card, user will need to create a new row.  
• Highlight Row > Right Click > Insert Row. 
• Add Merchant Name, Transaction Amount, Transaction Date (use same date format as 


other dates). 
• Follow same steps as above for Trip, FAST Category, Payment, etc. 


 
Separating Expenses in Hotel Folio 


• If there a hotel folio contains multiple FAST Categories, then create a new row for each 
FAST Category, such as Parking and Hotel, follow instructions above for “Adding Cash 
and/or Personal Card Payments”. 


 
Mileage 


• For Mileage, user will need to create a new row (Highlight Row > Right Click > Insert 
Row. 


• Add Merchant Name (Personal Car), Transaction Amount (put in the miles here - not the 
dollar amounts), Transaction Date (use same date format as other dates), Explain (Start 
and End locations and XX Miles). 


• Create a new row for each day of personal mileage. 
• When ready to submit expenses please add together all miles from Transaction Amount 


column (by trip) and enter total number of miles into PDF, which will do calculations for 
you. 


 
Filling out the CTE form 


• Using filters in Google Sheets/ Excel, fill out the CTE Trip Details. 
• Add the CTE Card (not out of pocket) expenses to the top right box as appropriate. 
• Add all expenses that you paid for and put that in the proper cell toward the bottom of 


the first page. 
• Check the FOAPALS. 
• Save CTE Form as “CTE Traveler’s Name Date” (month of the statement/ ending month; 


EX: CTE John Doe 01.2019). 
 
Upload to the Drive 


• Three documents will be upload to the drive: CTE PDF, Excel Sheet, TARS, Receipts 
PDF, CTE Statement. 


• Order of Receipts PDF is: 
• By Trip. 
• By Category from top row to bottom row of the CTE Reconciliation Form. 
• By Date of transaction. 


• Put them in the Ready for Tier 1 folder. 
• Order follows the CTE Reconciliation Form.  


 
 
 
 
 
 
 







Business Contracts Processing of CTE Card’s Purchasing Agreements Requiring UC 
Signatures 
 


• Requestor is responsible to facilitate all payments with finance. 
• BC processing starts once the requestor forwards the Agreement via email 


to businesscontracts@ucsc.edu.   
• Required Information: 


• Requestors full name. 
• Requestors full contact info. 
• Requestor’s department info. 
• Supplier’s full legal name and address (example: HP Inc., not Hewlett-Packard or 


HP or H.P., etc.). 
• Supplier representative's name and contact info. 
• Summary on product information that is to be purchased. 
• If applicable - summary of all pertinent information on the background of why the 


product is being purchased. 
• Any questions about the supplier's terms and conditions. 
• Any modification requests to the supplier's terms and conditions, and why the 


change is being requested. 
• BC will contact the requestor directly with any questions and/or instructions. 
• Requestor will be responsible for sending the document to the supplier for their signature 


and forward a soft copy back to BC. 
• BC will place a fully executed copy in the associated Gdrive folder. 


• Important:  Gdrive folder should NOT be used as the official system of 
record.  This responsibility falls on the department to keep the records of 
purchase outside of CruzBuy. 


• Because this has been executed outside of CruzBuy, the originating 
department/purchaser is the official office of record for this contract for 
legacy and audit purposes adhere to the UC document retention policy.  


• https://rim.ucsc.edu/retention/UCRS.html. 
 
Note: only Procurement Services has authority to sign contracts on behalf of the University. 
Re:  Signing Authority:  https://www.ucop.edu/business-resource-center/policies-and-
guidance/guidelines/delegations-of-authority.html 
 


 


 
 



mailto:businesscontracts@ucsc.edu

https://rim.ucsc.edu/retention/UCRS.html

https://www.ucop.edu/business-resource-center/policies-and-guidance/guidelines/delegations-of-authority.html

https://www.ucop.edu/business-resource-center/policies-and-guidance/guidelines/delegations-of-authority.html
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